RE NESAS Application Note

Renesas RX Family
Porting from CS+ to e? studio (with the Use of an Emulator)

Introduction

This application note describes the differences among the methods for setting and operating the E2 emulator
Lite, E2 emulator, and E20 emulator for e? studio when porting a project from CS+ for the RX family to e?
studio.

Target Device
RX family

Operating Environment
e? studio version: 2023-10
CS+ version: vV8.10.00

Refer to the Quick Start Guide for e? studio, which explains how to use the tool.
o e? studio Quick Start Guide for RX/RL78/RH850 Family (R20UT5293)

For the debugging functions of the emulators, refer to the following document.

e On-chip Debuggers Performance Property (R20UT0616)

This application note has been created on the basis of the case where an RX65N is in use with an E2 Lite.
However, the basic methods for setting and operating the emulators are common.
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Renesas RX Family Porting from CS+ to e? studio (with the Use of an Emulator)

1.

The help system of e? studio includes tutorials on the use of the debugger.

Introduction

When you proceed through the methods from creation to the debugging of a program according to the
tutorial indicated in the screen shot below, you can easily experience e2 studio. Start by trying the tutorial.

& Help - & studio - [m] x
Search: Scope: All topics
Contents &~ #F B 8 LR i e ==
L2 Eclipse Platform User Guide A . A
B/t Development User Guide Debugglng
= Bl e2 studio User Guide
= B General In this section, you debug the program using target board.
2 &2 studio Plug-in list (If vou do not prepare target board. you can perform the debugging the program by using simulator.)
# [ Renesas RL78 Simulator .
50 Code Generator Connecting a target board
= A 7 i
. Intsgrat-lcm Service You connect target board and PC.
= e2 studio Synchronise workspace with file system . -
(If you use simulator. jump to next step )
|5 Renesas Software Installer
# L Renesas Region specific devices The connector shape is micro-USB Type-B.
# [H Frequently Asked Questions Connect the USB connector to the computer by a USB cable
= 3 Import/Export If the power supply on the host side 1s on, the power is supplied to this product at the same time as connection of the cable.
= & Tutorials
# U LLVM for Renesas RL78 Tutorial Connecting a Debugger
+# U4 Renesas C compiler package for RL78 family Tutorial
# [ GCC for Renesas RL78 Tutorial In this step, vou start the debugging via select the debug configuration.
# 04 GCC for Renesas RX Tutorial . .
* 1. Select the e” studio menu [Run] > [Debug Configurations...].
® @ Building Prajects 2. [Debug Configurations] dialog 1s appeared.
% 0 Debugging Projects = When ?smg target board: ) i
@ Eclinse Marketplace User Guide Select "Renesas GDB Hardware Debugging > sample HardwareDebug".
-p P A Specify the following items on [Debugger] tab > [Connection Settings] tab.
B Eclipse Remote Developer's Guide
< Debug Confiqurations
€ JsoN Compilation Database Parser User Guide .
€ Qomph P2 Management Documentation v Create, manage, and run configurations g\_
e Oo[nph Setup Documentation < e
g [ ¥ 8] < >
Figure 1-1 Tutorial
2. Opening a CS+ Project in e?studio
2.1 Porting a Project
For how to port a project from CS+ to e? studio, refer to the following URL.
Porting from CS+ to the e? studio
2.2 Points for Caution
Points for caution apply when you are porting a project.
Refer to the following document and FAQ.
Project Conversion between e? studio and CS+ Notes and Tips
Error message when a project from Cube Suite+ or CS+ is imported into e? studio.
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Renesas RX Family Porting from CS+ to e? studio (with the Use of an Emulator)

3. Where are the Settings for Connection to an Emulator Made?
e? studio supports all of the emulators (E2, E2 Lite, and E20) that are supported by CS+.

You will not need to purchase a new emulator or remodel the target board.

3.1 Points where the Settings for Connection to the Emulator are Made

When you set the connection to the emulator in €2 studio, click on [Run] -> [Debug Configurations...] to open
the [Debug Configurations] window. After that, click on the name of debug configuration under [Renesas
GDB Hardware Debugging] and make the settings on the [Debugger] tabbed page.

In the simulator, click on the name of a debug configuration under [Renesas Simulator Debugging
(RX,RL78)]. Note that the positions where settings are made differ between the emulator and the simulator.

When you wish to change the emulator type, select the emulator from the [Debug hardware] drop-down list.

When you wish to change the microcontroller to be connected, you can select the new one from the [Target
Device] drop-down list. However, since the microcontroller setting for the project and that for connecting the
microcontroller to the emulator are dependent on each other in e2 studio, the new setting will not be reflected
on that for the target microcontroller of the project.

-] Debug Configurations m] x
| Create, manage, and run configurations @'\
} -
P o = o Mame: | sample HardwareDebin
Hitber bex] x| Select the emulator type.
[£] &rCas Application
= e+ - Barate foghiahan Debug hardware: [E2 Lite (700 ] TogetoeiceEErEEne T
LT EASE S| Debug settings — N
£l GDEMal snr e s withthe GOS8 Settngs  Conmnection Settings  Debug Tool Setting|  Select the type name of the
£ GDESN o later GDB Connection Settings micrecontroller to be connected.
@ Launch B
w Renetis GDE Hietfware Debugging @) Autostart bocal GDE server Hiost name of P address:
| 7 sample MardwaneDebug [ {2 Connect to remote GDB server GOR port nunber:
v [T T T
I £ sample Debug I Connection timeout (s): | 30 w
Debug settings GD8
P ,-
or use with i GDE Command: | ri-elf-gdb -re-fone-v2 Browsew | Vanables..
the simulator.
[T Step Miode

Additional GDE Server Arguments

Filter matched 10 of 12 items

2 o

Figure 3-1 Points where the Settings for Connection to the Emulator are Made

For changing the microcontroller for the project, also refer to the following FAQ.

Change a target device with e2 studio project
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3.2 Comparing the Settings for Connection to the Emulator
Make the settings for connection to the emulator on the [Debugger] tabbed page of e2 studio.

3.2.1 Main Differences of Setting Points
Figure 3-2 shows a comparison of the setting points which are common to CS+ and e? studio.

If there are no items of correspondence for the setting points, the setting points are different. Details will be
given in the subsequent sections.

Connection settings in CS+ Connection settings in e? studio
@+ RXE2 Lke Property Rl ||+ GOB Settings  Connection Settings  Debug Tool Settings
w Clock
- Extal Frequency[MHz] 24
Operating Frequency [MHz] 120,000
Clock Peamit Clock Source Change On Writing Internal Flach Memory Yes »
Main clock source EXTAL
Main elock fraguerey{MHz] 24,0000 < ¥ hennection with 1a
Operating fraguency|MHz) 1200000 Erruslator (Auto)
Allow changing of the clock source on writing internal fash mamary Yes > Connection Type Fine w
w Coni on MMag Clock Frequency[MHz] B0
Emulator serial No. Fine Baud 1.50 o
DEmOCl o8 ‘arget - Het Plug Mo -
Power target from the emulator (MAX 200ma) No - | v Power
ricaions m FIRE <3 Power Target From The Emulator (MAX 200ma) MNe w
L e bacd raefbps) 1500000 Supply Voltage (V) 33

e P— Mode pin
1280) ange starup bank

-CP0 Operating Mo
Input Mode of 1D code Specty the |0 code a3 8 3208 hexadecmal > . ‘“‘5":‘ ode T

| D cods I"' ister Settin v
- Fl— | e ! Single-chip mode

Startup bank
Sngle chip made + ~ Communication Mode
Sngechpmods | Mode Debug Mode v
Tieenaen 0ais ¢ .
== I Execute The User Program After Ending The Debugger
14
1D Code FFFFEFFFFFFFFFFFRFFFFFFEFFFFFFFF
Settings for the debug tool in CS+ Settings for the debug tool in e? studio
S5 AXE2Lie Property P =]+ GDB Settings Connection Settings Debug Tool Settings
~ Memory ~ 10
> = Use Default K0 Filename Yes v
Verify on writing lo 4 Yea 10 Filename S{support_area_loc
v Access Memory While Running v General Debug
Aczess by stopping execubon o
Update the display during execution Yes " Fleset After Reload Yes b
Update intervaljms] 500 l_"'y" em
v Register b Endian Little Endian_] -
FC display during the execution He >l Verify On Writing To Memary No | v
~ Break riternal Flash Memory Lvermnte =&
Type of breakpoints 1o be preferentially used Hordware break External Memary Areas O]
~_Syslem |
Debug the program re-writing the on-chip PROGRAM ROM o _ > Wark RAM SwnIAdd "_5’ kit
the program re-writing the on-chip DIATA FLASH He N Work RAM Size (Bytes) 500
0 T T T 7 T R ‘ ~ System
Execute the specified routine immediately after the user program stops Mo - > Debug the program re-writing the on-chip PROGRAM ROM No ~
- i . Debug the program re-writing the on-chip DATA FLASH Ne w
s3ge of trace function opFomhoTT et
J il and feution: N
Ei::;:::::m memory is ful wam .Irmamwm continue exd Execute fun;uon‘befor.r running user program No v
Bus mastsr of dats sccass cPU Address for start function C
Output timestamp Mo o Execute function after stopping user program Ne w
w Timer Adkdress for stop function 0
Use E4bit counter No Work RAM Start Address
Work RAM Size (Bytes)

Figure 3-2 Comparison of Setting Points between CS+ and e? studio (Example when an RX65N is in
Use with the E2 Lite)
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3.2.2 Setting for Overwriting the Internal Flash Memory

In overwriting of the internal flash memory by CS+, whether the original data are to be erased or retained
when downloading a file is set for the code flash memory and data flash memory as a whole. With e2 studio,
this setting is made in block units.

In the dialog box which is opened by clicking on [...] at the right of the [Internal Flash Memory Overwrite] item
on the [Debug Tool Settings] sub-tabbed page, you can set whether the internal flash memory is to be
overwritten without or after having been erased in block units during downloading.

The selected blocks are overwritten without being erased and the non-selected blocks are overwritten after
being erased.

Settings for a file to be downloaded in CS+ Settings for overwriting internal flash memory in e studio
2 RX E2 Lite Property ~ Memory
~ Download Endian Little Endian v
131 Verify On Writing To Memory No
CPU Reset after download Yes Internal Flash Memory Overwrite [582] @
Erase flash ROM before download Ye:
Erase data flash ROM before download Mo ¥
Automatic change method of event setting position Suspend event Q Overwrite Internal Flash Memory %
Number Address Range S
e eelepeed - @BLlEBEIF
1 @aleeedd - ealeeayr
2 eelopase - @B1lEBREF
3 ealeaace - ealeaarF
4 eeleeled - @8LlBE13F
5 ealealdd - ealealiF
B egleelse - e8LlBBLEF
7 ealeelCe - @alealFF
8 eeles2es - @BLBBLIF
9 ealee248 - @B1BB27F
1@ eeles2se - e0LlBB2EF
11 8elo82C8 - BBLBBIFF
12 eeleeaseg - @8LBB33F
13 eeloe348 - @BLBBSTF
A 1a ARTARIRAG - BATRARRE b

Select All | | Deselect All| []Show Only Selected

Selected blocks will be overwritten rather than erased
when the user program is downloaded.
Unselected blocks will be overwritten after being erased.

Cnce

Figure 3-3 Settings for Overwriting Internal Flash Memory
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3.2.3 Setting for Downloading a File to the Internal Flash Memory
Both CS+ and e? studio also support writing to the external parallel flash memory by using the External Flash

Definition Editor.

Using USD files or HEW scripts that have been in use with CS+ is possible, as is making new 1/O register

settings without using a HEW script.

After having set [Download Enabled] under the [External Flash] item on the [Debug Tool Settings] sub-
tabbed page to [Yes], specify the USD file or set the erasure of the external flash memory before
downloading in the dialog box which is opened by clicking on [...] at the right of the [External Flash Definition]

item.
v External Flash
Download Enabled No When 1/0 registers are to be
External Flash Definition set without usinga HEW
External Flash Definition script
External Flash Definition
External Flash Definition
10 Register Settings [a @7
A 4 r
&) Edit External Flash Definition Specify a USD file generated by the | g b 4 15 Register Settings %
external flash definition editor.
Browse for external flash User System Definition file 10 Register values applied after each reset and before download
USD file: | Variables... | | Browse... Address Size Value
[ Chip Erase
‘Erase before writing' is the default for all unspecified memory sections:
Address Size Erase Action
£ >
Enter valid hexadecimal values
Address (hex) Size (hex) Erase Type It o) | | Add Remove
| | | |O’vem~ritewithout erasing )
Size (hex) 1 byte ~
Value (hex)
Add Section move Selec Remove All Sections | | [TEeri E-qran
Clear All Data
QK Cancel
Cncel

Figure 3-4 Setting for Writing to the External Flash Memory

When you write to the external flash memory, you need to change the operating mode of the microcontroller
to the expansion mode before writing by using a HEW script or the [IO Register Setting] item.

For details on USD files and HEW commands, refer to the user’'s manual of the external flash definition

editor.

R20AN0741EJ0100 Rev.1.00
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4. Launching the Debugger (E2, E2 Lite, or E20 Emulator)

4.1 Launching the Debugger from e? studio
For details on the method for launching the debugger from e? studio, refer to the following FAQ.

How can | launch debugger in e2 studio?

4.2 Setting a File for Downloading and Command Processing before and after
Downloading

With the default setting, downloading proceeds after the debugger is launched in the state where the
debugger had not currently been launched in CS+ or e2 studio.

In e2 studio, the [Startup] tabbed page in the [Debug Configurations] window is used to add the file for
downloading or change the settings for the file.

However, the [Debug Tool Settings] sub-tabbed page is used to reset the debugger after downloading.

Note that the names of the load module files are of the form “*.x” for CC-RX and “*.elf” for GCC in e2 studio
although they take the form “*.abs” in CS+. The [Image] of [Load Type] is equivalent to [Object] in CS+.

In €2 studio, the [Startup] tabbed page in the [Debug Configurations] window is also used to operate the
target in the debugger when the debugger is launched or before or after downloading.

This operation corresponds to a hook transaction in CS+.

Figure 4-1 shows a comparison of the points in e? studio where items that are common to those for CS+ are
set.

Settings on the [Download File Settings] tabbed page for CS+ Settings on the [Startup] tabbed page for e2 studio
&3 RXE2 Lre Propesty
w Download [] Main | %3 Debugger | = Startup| B Source| [7] Common
o DO ioad files Initialization Commands

ICPU Reset after download Yes [ Resat and Delay (seconds}:

Erase flash ROM before download Yes

Erase data flash ROM before download No . [ Hait

Automatic change method of event setting position Suspend event
. :

Execute to the specified symbal after CPU Reset Yes |

Specified symbol _main |

The upper limit size of the memory usage [MByiss] 500 Load fmage and symbots

Filename Load type Offset (hex)  On connect

Download Files X | EA Program Binary [sampl... Image and Symbols 0 Yes

Download file property:
~ Download file information

Add...

Download object Yes

Download symbol information Yes
Spechy the PIC/PID ofiset No

Genarate the information for input ¢ Yes

FRuntime Options
[ Set program counter at (hex):

[ Set breakpaint at:
[ Resume

File [ Run Commanas
e Specdy the file to be downloaded. 1
CSet 0 7 w ZAEESTF

oot | [ 10
Settings for hook transaction in CS+ Settings for the debug tool in e studio
£x RXE2 Lite Property ) -
~ _Hook Transaction Seffings GDB Settings  Connection Settings Debug Tool Settings
B Before download v 1o
download o dowi T 1 Use Default IO Filename Yes v
After LFU reset under breaking Fier CPU reset under breaking[0] 10 Filename 3
Before running Before running[0] General Debug
After breaking Hter breaking[0] —>| Reset After Reload Yes v
Figure 4-1 File to be Downloaded and Command Processing
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Note that the command format differs between CS+ and e? studio; GDB commands are used in e2 studio.

The following is an example of the statements for hook transactions having been converted to GDB
commands.

SYSTEM.ROMWT 0x02 - set {char} 0x0008101C 0x02
SYSTEM.PRCR 0xa503 — set {short}0x000803FE = 0xa503

4.3 Disconnecting e? studio from the Debugger
When e? studio is to be disconnected from the debugger, select [Terminate] or [Disconnect] from the [Run]
menu or clickonthe ® or # button on the toolbar.
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4.4 Hot Plug-in Connection

With the hot plug-in function, you can connect the emulator to the target board during the execution of a
program and debug the program while it is running.

This section describes points for caution when using the hot plug-in function to connect an emulator in e2
studio.

CS+ has a selection for making a hot plug-in connection in the menu. In e? studio, start by selecting [Run] ->
[Debug Configurations...] to open the [Debug Configurations] window and specify [Yes] for [Hot Plug] on the
[Connection Settings] sub-tabbed page on the [Debugger] tabbed page. After that, launch the debugger
through the normal launching method.

Note that you should select [Symbol only] for [Load Type] of the file registered with [Load image and
symbols] on the [Startup] tabbed page before launching the debugger.

In addition, deselect the checkbox for the setting of [Breakpoint Setting Destination]. Selection of this
checkbox may lead to an error during connection processing.

When a debugger is launched, a message will appear in the dialog box. When you connect the emulator to
an active target board and click on the [OK] button, the debugger will be connected to the microcontroller
through hot plug-in.

Connection settings in e? studio Settings on the [Startup] tabbed page for & studio
GDB Settings Connection Settings  Debug Tool Settings Ui g e gylias
~ Clock Filename Load type Offset (hex)  On connect
Main Clock Source EXTAL Program Binary [sample.x] Symbols only a Yes
Extal Frequency[MHz] 24
Operating Frequency [MHz] 120,000

Select [Symbol only] for [Load Typel.
Permit Clock Source Change On Writing Internal Flash Memory Mo d ISy o L ypel

~ Cennection with Target Board

Emulator Specify [Yes] for [Hot Plug] and
Connection Type launch the debugger through the
ITag Clock Frequency[MHz] normal launching method.

Eine Baud Rate[Mbns] 120

Hot Plug No

Deselect the checkbox for [Breakpoint Setting Destination].
ounter at (hex):

| []5et breakpoint at: main

Figure 4-2 Settings for a Hot Plug-in Connection
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5. Debugging Features

For the differences between debugging features when the emulators are used with particular
microcontrollers, refer to On-chip Debuggers Performance Property.

Fundamentally, there are no differences between the debugging features of e2 studio and CS+.

5.1 Basic Debugging Features

With e? studio, programs can be executed, stopped, reset by the CPU, downloaded, or step-executed from
the menu or toolbar, in much the same ways as with CS+. For the main features, refer to section 5.4, Basic
Debugging Features, in the e? studio Quick Start Guide for RX/RL78/RH850 Family.

5.2 Breakpoints

In e2 studio, breakpoint features are usable in the same ways as with CS+. Note that breakpoints are
managed in the [Breakpoints] view and [Eventpoints] view.

5.2.1 Setting Program Counter (PC) Breakpoints
In e2? studio, breakpoints can be set in the left margin of the editor window (the space indicated by a red
frame in the figure below) in the same way as in CS+.

Double-clicking on the line showing an address will set a breakpoint there. When the address specified by
the PC reaches the breakpoint, a break will occur.

Double-clicking on a line where a breakpoint has been set removes the breakpoint. Note that a breakpoint is
removed by single-clicking in CS+ but this requires double-clicking in e2 studio.

(]
A breakpoint set by this method is registered in the [Breakpoints] view ( ©), which is opened by clicking on
[Window] -> [Show View] -> [Breakpoints].

In the [Breakpoints] view, you can specify or modify the priority of a hardware breakpoint or software
breakpoint among the registered breakpoints or refer to the state of the setting of breakpoints.

For details, refer to section 5.4.1, Breakpoints View, in the e? studio Quick Start Guide for RX/RL78/RH850
Family.

Note that a breakpoint specified by this method leads to execution stopping before execution of the specified
line (a “before PC” break).

Note also that if a setting for [Ignore count] is made, a break will occur after the breakpoint condition is
satisfied the specified number of times but the execution of the user program will no longer be in real-time.
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{8} camnle ccfn (6 camnler X | [l resetprg.c L] meyslackes —= P (9 Variables | % Breakp.. X |I5 Project... | & Express...| @® Eventp... | i'| IOReq..| = O
1| A breakpoint (PC break) can | A specified breakpoint can %

sample.c[] ; 5 P A e | B ol =
be set by double-clicking on | entry.h* be managed in the P RRP 3P| 5 3

the line showing an address. [Breakpoints] view !Z]vo sample.c [line: 21] [type: “‘“‘M"'ﬂl
e [

volatile int count=9;

| Check the properties of the breakpoint. |

= void main(void)

€8 Properties for C/C++ Line Breakpoint (m] X
while (1) {
PIN_WRITE(LED6) = ~PIN_READ(LED6); C v v 8
counti-+; oo Class: C/C++ Line Breakpoint
Actions
/* Delay 50¢ milliseconds before r¢ Filter Type: Hardware v
20725 R_BSP_Soft Delay (500, BSP_DELAY. - -
} L 8SP_Softwarcbelay( = 4 File: C:¥Users¥a5090538¥e2_studio¥sample¥sample¥src¥sample.c
b } Line number: |21
— [ Enabled
Condition: l

Ignore count: [0

B Console X | i Registers|[2] P& @ 27-h-7597-| G} Debugger Co

T
0
o

sample HardwareDebug [Renesas GDB Hardware Debugging] [pid: 60]

Emulator Information: ~
Emulator Board Revision E2LITE Rev.®
User Vcc 3.3V
USB Bus Power 4.95 Vv

Finished target connection

GDB: 49225

Target connection status - OK
Target connection status - OK
Starting download

7/~
Finished download ‘\3) Apply and Close Cancel

Hardware breakpoint set at address @xffe@e7e5

Figure 5-1 Setting a PC Breakpoint (1)

Clicking on [Renesas Views] -> [Debug] -> [Eventpoints] from the menu opens the [Eventpoints] view.

When you click on [Add] in the dialog box which is opened by clicking on [Event Break] and specify
[Execution Address] for [Eventpoint Type] in the [Add Eventpoint] dialog box, a break of the same type as a
PC break is set (although it is not displayed in the editor).
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{8 sample.scfg |€] samplec X | L) resetprg.c L&) meu_clocks.c = B ||(= Variables | % Breakp... |\( Project... &7 Express.. @® Eventp.. X |[i | IOReg.., = O
. ®* FILE : sample.cf ® X RS | Pc2/8OA: /4 | 8 | r#
#include “r_smc_entry.h”
Type Address Data Count Tirr
void main(void); [ 6 Trace Start
volatile int count=@; a ﬂ Trace Stop
[1 ¥ TrceRecord
B = void main(void) v [7] ©¢ Event Break
) M ORr 0xfe00705
H while (1) { g Timer Start
1 e PIN_WRITE(LED6) = ~PIN_READ(LEDS); -~
. L\ = &> Timer Stop
. GO contes;  |e - Set Oxfe00705 for
= [Execution Address].
* Delay 500 milliseconds before returning * g EditE %
) oftwareDelay (500, BSP_DELAY MILLISECS); | i Eventpont _\/
A breakpoint has been set ibeailo s = )i |
here although it is not ; > ;
displayed in the editor. Eventpoint Type: | Execution Address
Address Condi
Execution Address: 30:‘&00705 v:
4 >
1
q
e 1 =
D Console X | 1ili Registers| (2] B8 @ 27-+-759%-| &3 Debugger Console| [J Memory v~ =0
sample HardwareDebug [Renesas GDB Hardware Debugging] [pid: 60)
Emulator Information: ~
Emulator Board Revision E2LITE Rev.@
User Vcc 3.3V
USB Bus Power 4.95 v - ;
Finished target connection [ rigger Count: Timer:
GDB: 49225 Comment: [ 1
Target connection status - OK L -
Target connection status - OK
Starting download
Finished download Cancel
Hardware breakpoint set at address @xffeee7es

Figure 5-2 Setting a PC Breakpoint (2)

When [Pass count] is selected and a value is specified, a break occurs when the condition has been
satisfied. In this case, real-time performance is maintained.

However, in the case of a breakpoint set by using this method, execution will be stopped after the instruction
at the specified address is executed (a post-execution break). Thus, the breakpoint may lead to stopping at a
location several instructions after the address where the breakpoint was set.

Hardware breaks set in the editor and breaks set for [Execution Address] share the same resources.

Therefore, we recommend that you set the PC break at the source line in the editor and confirm it in the
[Breakpoints] view.
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5.2.2 Generating a Break in Response to Access to a Variable or to a Specified Address

In €2 studio, in much the same way as in CS+, if you want a break to be generated in response to access to
a variable and at a specified address, you can set the break by setting reference to the variable in the

[Expressions] view.

Click on [Window] -> [Show View] -> [Expressions] ( 95" ) to open the [Expressions] view.

You can set an eventpoint for a data access break by registering the variable to which reference is to cause
a break, selecting the variable, and right-clicking on [Renesas Eventpoint] -> [Add Event Break].

&) Add Eventpoint X
_ Eventpoint Type: | Data You can also set detailed
15 sample.scfg L] sample.c X | [€] resetprg.c = O ||t Variables | ® Breakp... |3 Project .. | % Express.. X conditions.
FILE i sample. % 5| Address Settings i
#include "r_smc_entry.h” g5  Data Access Settings
- Expression Type Value Address
id main(voi o Address: [aicount ][
void main(void); CRlcount PR =
) g Adgr,  SelectAl ik Address Conditions
volatile int count=8; ooy Fxnressine Ctl+C
Wh ol lect O None
. Vhen a variable is selected
¢ = wvoid main{void) B
and an eventpoint is set, an O Mask
while (1) { access break for the variable Value: Equals
9 ffe0708 PIN_WRITE(LEDG) = ~PIN_READ(LED6); is automatically set —*
S @ Range
4021 R count++; =
Find... 1 o End Address: oxlczb | e
3 * Delay 580 milliseconds before returning * ?
R_BSP_SoftwareDelay(500, B5P DELAY MILLISECS); Show Details As ’ Type: Inclusive
\ } s Add Watch Expression...
Disable 3
[ Trigger Count: Timer:
Edit Watch Expression... Comment: [ gicount)
% Add Watchpoint (C/C++)...
Select a variable and right- Fy CostToType Cancel
click on the name to open x[] Display As Array...
the menu. 5% Enable Real-time Refresh

Real-time Refresh
Renesas Eventpoints
»  Watch

ST

>| © Add Event Break ‘l

Figure 5-3 Setting a Data Access Break (1)

For details on the [Expressions] view, refer to section 5.4.2, Expressions View, in the e2 studio Quick Start
Guide for RX/RL78/RH850 Family.

You can confirm the set event in the [Eventpoints] view, which is opened by clicking on [Renesas Views] ->
[Debug] -> [Eventpoints] from the menu.

You can directly set a data access break by clicking on [Add] in the dialog box which is opened by clicking on
[Event Break] in the [Eventpoints] view and specifying [Data Access] for [Eventpoint Type] in the [Add
Eventpoint] dialog box. Use this method to directly specify an address value.

Note that a break specified by this method also leads to stopping after the condition has been satisfied. In
such cases, the program may only be stopped after several further instructions have been executed.
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{8 cample.scfg L) sample.c X | [€) resetprg.c = 8 || Variables | ®o Breakp... | Project... @ Express.. @® Eventp.. X |[i’| IOReg..| = 8
®* FILE + sample. c[] w X% | PC:1/80A:0/4 | S | 4
3 #include “r_smc_entry.h” .
1 Type Address Data Count Timr
1 E void main{void); [ & Trace Start
14 volatile int count=g R L] Trace Stop
15 Double-click on [Event 18 Toace Becocd
16 &fe  =void main(void) Break] to add an event [ €Y Event Break
17 { ) break. T Timer start
o N while (1} { & Timer Stop
19 PIN_WRITE(LED6) = ~PIN_READ(LEDG);
a2l countésd; =
23 /* Delay 580 milliseconds before returning */
24 R RSP SaftwarefelauSA8. ASE NFLAY MTILTSECS):
25 €
' Trigger: |OR ~
T ]
Type Address Data Count  Timer . N
@ Add Eventpoint | Specify [Data Access]. X
Eventpaint ype
Address Settings  Data Access Settings
Address: Creic VI - |
" Address Condition:
@® None You can directly enter an
O Mask address value.
1 Value: Equals
Add... ot 2 q - g >
CITLE PCOTEOAT /4 All: 0 e) Range
— 1 End Address: -
B Console X | Lt E ~-=0
sample HardwareDebug |Renesas GUE Haraware Debugging) - [pea: 3] Type: Inclusive
Target connection status - OK -
Target connection status - OK
Starting download [ Trigger Count: Timen
Finished download
Hardware breakpoint set at address @xffe@e7es (_urnrl\ent:[ o
s

Figure 5-4 Setting a Data Access Break (2)

For details on the [Eventpoints] view, refer to section 5.4.7, Eventpoints View, in the e2 studio Quick Start

Guide for RX/RL78/RH850 Family.
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5.3 Tracing

e? studio allows the use of trace features which are the same as those of CS+.

5.3.1 Setting Tracing

In e2 studio, open the [Trace] view by clicking on [Renesas Views] -> [Debug] -> [Trace] from the menu. Click
onthe ¢/ button in the [Trace] view to enable collecting trace information, then set tracing in the [Trace
Acquisition] dialog box, which is displayed by clicking on the # button.

The large-capacity trace feature involves the use of dedicated tracing pins and is used to set the external
output of tracing. Note that this is only available with the E20 emulator.

Other features that are grayed-out in the figure below are not available for the RX family.

Settings for the debug toal in CS+

[Trace] view in 2 studio

This item is not available et 8TAG
for the RX family. Trace the fet

Start address for
Access{without data)

End address for
Access{without data)

IS F I E— - -
= RXEZ2 Lite Property 188 Teace X | ) Memory ( )— S| 7 i v @ Ol g =0
v Memory

Memory mappings [231 ata Size AW BUSMas_ Type BCN BnnchT. O Enable the trace

Verify on writing to memory Yes features to set tracing.
v Access Memory While Running

Access by stopping execution Mo B Trace Acquisition *

Update the display during execution Yes Trace Acquisition  Qutput Software Trace from LPD

Update interval[ms] 500
+ Register

PC display during the execution No Trace Mode: Fill until stoy >
v Break These items are

Type of breakpoints to be preferentially used Hardware break Trace Output: Donoteutl only available with
v System the E20 emulator

. Trace Type: Brand] v

Debug the program re-writing the en-chip PROGRAM ROM Mo

Debug the program re-writing the on-chip DATA FLASH Mo | U Trace Capacity tframes)

Execute the specified routine immediately before execution of the user program Mo

Execute the specified routine immediately after the user program sto Mo Timestamp Frequency Divider Mo ffequency division v
w | Trace . "

Usmoe of irace function — Enable Timestamp Display: =

Operation after trace memory is full Qvenwiite trace memory and continue execution| | Accumulate Timestamp:

Trace data type Branch + Data access Bus Master Of Data Access: CPU i

Bus master of data access CcPU

Output timestamp Mo Software Trace: Internal

Cancel

Figure 5-5 Setting Trace

Features
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Renesas RX Family Porting from CS+ to e? studio (with the Use of an Emulator)

5.3.2 Setting Conditions for Starting and Ending Tracing

If you do not want to start the acquisition of trace information in response to executing the user program but
want to start and end acquisition in response to the execution of instructions at specific addresses, select
[Renesas Views] -> [Debug] -> [Eventpoints] from the menu, open the [Eventpoints] view, and double-click
on [Trace Start] and [Trace Stop] to open the relevant dialog boxes. In each dialog box, click on [Add] to set
the condition for starting or stopping trace acquisition.

5 sample.scfg L€ sample.c X | [g) resetprg.c = B ||®= Variables | % Breakp... |I( Project... |G Express... |@® Eventp.. X || IOReg..| = O
3 ®* FILE : sample.cf] w X ﬁ'* 2 PC 1/8 0A: 0/4 : | =

10 #include "r_smc_entry.h"
11 Type Address Data Count Tirr

void main(void); [] 5 Trace Start
[] @ Trace Stop
O ¥ Trace Record
[J €0 Event Break
& Timer Start
&> Timer Stop

Double-click on [Trace Start] or
volatile int count=e| [Trace Stop] to set the conditions
for starting and ending tracing.

= void main(void)

{
S while (1) {
PIN_WRITE(LED6) = ~PIN_READ(LED6);

b4
Trigg 00 =
Specify [Execution Address] or [Data
. 1 Access] to set up the conditions for ]
3 || Type Address Data Count Timer | & Add Eventpoir] starting and ending tracing. X
Address Condition
Execution Address: v e
|
Add... SRR PT 078 OA: 0/4 All: 0
—l >
Project
| B Console X | i Registers| @ Smart Browser G Debugger Console| € Trace| [} Memory [ Trigger Count: Timer: =l
sample HardwareDebug [Renesas GDB Hardware Debugging] [pid: 3] Comment:
| Target connection status - OK A
Target connection status - OK
| Starting download
| Finished download Cancel
| Hardware breakpoint set at address Oxffe@e7es 7
Figure 5-6 Setting the Conditions for Starting and Ending Tracing
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5.3.3 Setting Conditions for Data Access Tracing

If you do not want to acquire all the data access to the user program but want to trace only data access to a
specific address, double-click on [Trace Record] in the [Eventpoints] view and click on [Add] to set an event.

{8} sample.scig (€ sample.c X | l€] resetprg.c = B || (0= Variables | % Breakp... |/ Project... & Express... | @® Eventp.. X [/ [OReg..| = B
@®* FILE : sample.c[ v X g“ = ‘ jpc 1/8 OA: 0/4 e | =
#include "r_smc_entry.h"
Type Address Data Count Tirr
void main(void); 0 & Trace Start

[] 8 Trace Stop

[] ¥ Trace Record

Double-click on [Trace Record] to

volatile int countd i
add data access conditions for the

= void main(void) address to be traced. [J €9 Event Break
. )& Timer Start
while (1) { D. Timer Stop
PIN_WRITE(LED6) = ~PIN_READ(LED6);
Trigger: |OR
Type Address Data Count Timer Channel Comment .
@ Add eventpoint ["1D315 Access] has been specified. X
Eventpoint Type: |Data Access
Address Settings  Data Access Settings
Address: [ v| B
Address Conditions
@ None
O Mask
. Value: Equals
Add... PCWUOR WA AT U/4
ORange
End Address:
>
1T Project ~davea Type: Inclusive
B Console X | k!¢ Registers| @ Smart Browser| G} Debugger Console| 8 Trace| [J Memory = 3 F O
g Enter the address and I
sample HardwareDebug [Renesas GDB Hardware Debugging] [pid: 3] [JTrigger Count: access:condiions
Target connection status - OK Comment: | - "
Target connection status - OK |
Starting download
Finished download
Hardware breakpoint set at address @xffe@@7e5 Cancel =

Figure 5-7 Setting Data Access Tracing

5.3.4 Trace Eventpoints

You can set trace events in the [Trace Eventpoints] dialog box, which is opened by clicking on the
button in the [Trace] view.

For details, refer to section 5.4.9, Trace View, in the e2 studio Quick Start Guide for RX/RL78/RH850 Family.

5.4 Performance (Timer Measurement) Features

As with CS+, performance measurement (measurement of the time for a specific range in the program) by
using the timer measurement features is available in e? studio.

For the method of setting this feature and confirming the result of measurement, refer to the following FAQ.

How can | measure an execution time for the specified interval?

Note that RX600/700 has two timer channels enabling the measurement of the execution time for two ranges
in the program. However, if the two timers are configured to operate as a single 64-bit timer, only a single
range is measurable and only Timer 1 is displayed.
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5.5 Manipulating Memory

For details on opening the [Memory] view of e2 studio and on its basic features, refer to section 5.4.4,
Memory View, in the e2 studio Quick Start Guide for RX/RL78/RH850 Family.

The following sections describe ways of manipulating memory which are frequently used in the debugger.

5.5.1 Filling Memory

Batched changing of all values in a range of memory (filling memory) in e? studio is enabled by selecting [Fill
memory] in the dialog box which is opened by selecting [Find/Replace/Fill] from the menu of the Memory

view.

& Console | Registers @ Smart Browser E Debugger Console | S8 Trace [i] Memory =

=

8

Layout 3

Qéé oy Q.'><h [ ':"‘ E' = <§>| EU v Real-time Refresh Preferences...
Manitars 2= 9 %% |0x00000000: 0x0 <Hex Integer> < | &b New Renderings... Find/ReplacefFill...

@ 0x00000000 Address B -3 4-7 8- B C-F ol Find Nexw—___
0000000000020000 4537CCSD  187FG90E  @ICAIFEE Click on [Find/Replace/Filll from
80PBBEABBRERRB1e  /263BF94 E9CBAAEF FBDAI317 BAF734DC the menu of the Memory view.
0EEEGRARREERAE28  OGIACSED  2ECB3ES1  CC7EFSAS  4AO7B7F2 —

@eEeRARPREREA3E @1E/DCCY  BC587658  (A91792D  G2ABF1E3 '
0DOORERADROBERAD DADSIEIE  BGBIS6AD  BEE7GE22  AD2AMGET Il SR Al HE SR
@ePEEREPPEERRESE 53755223  75E505FD  34E448DE  B6575909

0EEERARROOREESE  GOGSEADD  CE49303C  E3BAISDE  AMIB192C v

E‘ Result of filling memory F &= New Renderings...

Select [Fill memory].

8 Find/Replace/Fill Memory

‘:Dfﬂ\nwrnnq

Address 3 4 -7 8 -8B
BaeRaRRARREREREE

BoBREEEBEBRERELE
boRRERERRRRERE2E
BEBREREBABRERESE
boRRERERRRREREAD
DeBRaRERRERERE5E
PERRGRABARBAREGE

(O Finet
Replace/Fill with: [ oxFFFF | |
Direction Range
- Start address: | 0x0000 v
Specify the address range of
memory to be filled. End address: | 0x0100 v‘
- A
c F Format Options
F () ASCll string Wrap searc
F (® Hexadecimal C ve
F QO0ctal Word length: | 2bytes
F ) Binary
; Qowima [ Datslongt |
F () Byte sequence
EEFEEFEE v
N
@ Repla

I Replace All | Close

Figure 5-8 Filling Memory
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5.5.2 Saving Contents of Memory
To save contents of memory in e2 studio, click on the Export icon ( ¥ ) in the Memory view.

When the dialog box is opened, specify the type, address range, and name of the file where the contents of
memory are to be saved and click on the [OK] button.

B Console | 35 Registers @ Smart Browser % Debugger Console | %8 Trace a Memory X = a
4] R - . .
o <='|=€>| Click on the Export icon in the
Menitars = % % 0x00000000 : 0x0 <Hex Integer> 3 | o= Mew Renderings... Memory view.
@ Ox00000000 Address @ -3 4 -7 3 -8B C-F &
A0AEEERERRRRRREE W 4Ez7rren 129ccone garsgcos Y
BOGE0DDEEROOER1E  7263BFI4 & EBeport Memory . o X
BPEGARGERGERRA20 5 Select [SRecord] for saving — .
; i i Enter the addresses to
Format: |SRecord w}~ the values in an mot file. nt
BeoobbpoEERREEIE define the range.
BooobbboEERREBLIE
AEGE0ERRRREAEASE Startaddress:l |Dx0 | End address: |Dx100 ||Length: |256
B000000000000860 1 File name: I|sample.mot | Browse... |
SRecord format only supports 32-bit address spaces —1'1er the file name.
y supp pa

Figure 5-9 Saving Memory

5.6 Manipulating Registers

e? studio has views for reference to and modification of general-purpose registers and I/O registers,
respectively.

For details on opening the views and their basic features, refer to section 5.4.3, Registers View, and section
5.4.8, 10 Registers View, in the €2 studio Quick Start Guide for RX/RL78/RH850 Family.

For the method of saving the values of I/O registers in a file, refer to the following FAQ.

How to save /O register values to a file
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5.7 Automatically Updating Memory or Variables during the Execution of Programs
In e2 studio, automatic updating is available in the Memory view and Expressions view.

5.7.1 Automatic Updating of the Memory View

In e2 studio, clicking on the real-time refresh button (“53) in the Memory view leads to updating of the memaory
values which are shown during the execution of programs to the latest values at a set refresh interval.
Updated values are indicated in red.

Click on thereal-time refresh
button.

P e
(6% 5 0ol B 6~
Monitors 2o 3 5% x1c20:0x1C20 <Hex Integers X | oo New EFiNgS...

@ x1c20 Address @ - 3 4 -7 8 - B C-F ~
EEE00E0088681C28 COCEEEEE EEEE0668 BEEE8836 FFE@BEBC
EEE0PEADERERLC38 FFERBECE FFE@BE04 BEEE066E BBBa1C20

aeacepapapRRlC4a  GEEELEZ24 aaaaasal aeealCas aeaalcas

agacepapapRRlCse  GEEOLCES aaealcss aeealCas aeealcas

GgacepapaRRRlCER  GEEOLCES aaaaas @

a@gaoepapapRRlC7E GREOLCES aaaoaaaa aaaaaaaa aBaaaa
s

gpeaopeoaeelise  ocoooo

L
The color of the button changes to
indicate that automatic updating has
been enabled.
! . =] Q
(B & 5 oo el B 5 - ¢
Monitors g5 3 % O0x1c20: 0x1C20 <Hex Integer> X | g New erings...
@ Ox1c20 Address @ - 3 4 - 7 8 - B C-F "
seoceeeennnnlC2e [liiaadll ©0eeeasn , 00000044  FFE@@EBC
GePEAREEREERA1C3e  FFE@BRCH FFE® RARAT L 20
BERBRREREREE1CAE BEEE1E24 BEEE The value EIJ[.EII"' aogress '."-.f.r‘IEr" WwWas
peoooeopeopelCse eeeelcss  pepe| UPU3ISC GUringihe execution of the
user program Is indicated in red.
GEPEABREREER1CEE  BBBRLCAS Ba6e
EEPRABRERRERLICTE  GBBRLCES BRBREREE BEBREREE BEBREREE
BEPRERPERERRLICER  PEREREEE BEPREREE BEEREREE 816816814 v
Figure 5-10 Automatic Updating of the Memory View
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5.7.2 Automatic Updating of the Expressions View
In e2 studio, enabling or disabling of automatic updating can be specified for the respective variables

registered in the Expressions view.

When you select a variable, click on the right mouse button to open the pop-up menu and select [Enable
Real-time Refresh]. The <& icon is shown to the left of a variable which is to be automatically updated

during the execution of a program.

In addition, clicking on the * button in the Expressions view disables automatic updating of all variables.

Select a variable for automatic
updating and click on the right

()= Variables | % Breakl 10,50 button to open the pop-up  [ENTP-- i|IOReg..| = O
menu. Q%[0 2
Expression Type W Address hameD;t;E;:TlSﬂ-
()= count stetitet eSerfHex) Ox1c28 Default:154
Decimal:154
Hex:@x9a
sz zEia S Binary:10@11010
=| Copy Expressions Cirl+C Octal:8232
¥ Remove
% Remove All
Number Format ¥
Add Expression Group >
Find... Ctrl+F
Show Details As >
b Add Watch Expression...
Disable
Enable
Edit Watch Expression...
5% Add Watchpoint (C/C++)...
%o CastToType.. Click on [Enable Real-time Refreshl]. ‘
#[1 Display As Array..
¢ Enable Real-time Refresh I_l Expression Type Value Address
Real-time Refresh > iIe it Ox9a(Hex)  Ox1c28
Renesas Eventpoints -
Y Watch An icon is added to indicate that automatic

updating has been enabled.

Figure 5-11 Automatic Updating of the Expressions View
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6. Writing in the Same Way as the Flash Writer
e? studio has a mode for only writing to the on-chip flash memory. CS+ is not equipped with this.

To start the debugger, change [Mode] under [Communication Mode] on the [Connection Settings] sub-
tabbed page from [Debug Mode] to [Write On Chip Flash Memory]. After that, on the [Startup] tabbed page,
specify [No] for [On connect] for the file to be downloaded.

After the debugger has been started, manual downloading proceeds with writing to the flash memory.

If you download the file in [Debug Mode], the debugger will overwrite all bytes of the ID code with OXFF and
rewrite the endian select register in response to the settings of the debugger. However, if you download the
file in [Write On Chip Flash Memory] mode, the results will be the same as in the case of using the flash
writer to write to the flash memory.

In [Write On Chip Flash Memory] mode, the user program can be executed without disconnecting the
emulator from the board after the debugger session has been terminated.

Connection settings in e studio

£ Main % Debugger| = Startup| [] Commen | & Source

Debug hardware: | E2 Lite (RX) ~| Target Device: | RSF385ME

GDB Settings  Cennection Settings  Debug Tool Settings

w Clock
Main Cleck Source EXTAL W
Extal Frequency[MHz] 24
Operating Frequency [MHz] 120,000
Permit Clock Source Change On Writing Internal Flash Memory Mo W
w Connection with Target Board
Emulator [Auto)
Connection Type Fine W
IMag Clock Frequency[MHz] 6,00
Fine Baud Rate[Mbps] 1.50 W
Hot Plug Mo W
v Power
Power Target From The Emulator (MAX 200maA) Mo W
Supply Veltage (V) 3.3
w CPU QOperating Mode
Register Setting Change the mode from [Debug v
Mode pin Mode] to [Write On Chip Flash
Change startup bank Memory].
Startup bank [ Edre,
v Communication Mode
Mode Write On Chip Flash Memary W
Execute The User Pregram After Ending The Debugger Yes W

Startup settings for &2 studio

Load image and symbols

Filename Load type Offset (hex)  On connect
Program Binary [sample.x] Image cnly 0 Mo
{

Specify [Image only] for [Load

type] of the file to be downloaded. Specify [Nol for [On connect]

Figure 6-1 Settings for Only Writing to the On-chip Flash Memory
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Renesas RX Family Porting from CS+ to e? studio (with the Use of an Emulator)

For details, also refer to the following FAQ.
RX program runs via E1/E20 but doesn't work without emulator

7. FAQs
Also refer to the following FAQs, which will be helpful for using e? studio.

e2 studio FAQs
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic 1Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Viu (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LS| is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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